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Software Licensing Information

Electronic Learning Systems, Inc. grants to you the right to use ChatNet Free and to
make backup copies. The complete unmodified package, that includes the User’s
Manual and order form, may be distributed free of charge without prior consent. 

USER LICENSE LIMIT
ChatNet Free is limited for use to three (3) users. If you wish to make ChatNet
available to additional users you must purchase a 10, 50 or 250 user license. See
order form for purchase information. Purchasers of ChatNet will receive a printed
User’s  Manual,  registration  card,  installer  diskette  with  latest  release,  toll-free
technical support, and a 30 day money back guarantee.

COPYRIGHT
ChatNet  Free  software  and  its  User's  Manual  are  copyrighted  with  all  rights
reserved. Under U.S. copyright law, the software program enclosed and its User’s
Manual  may not  be modified,  in  any way,  without  written consent  of  Electronic
Learning Systems, Inc. Violators of this copyright are subject to prosecution under
Federal copyright statutes.

DISCLAIMER
In  no  event  shall  Electronic  Learning  Systems  nor  anyone  else  who  has  been
involved in the creation, production, delivery, or support of the program or manual
be  liable  for  any  direct,  indirect,  special,  consequential,  or  incidental  damages
arising out of the use, the results of use, or inability to use the program or manual
even if  Electronic  Learning  Systems has  been advised of  the  possibility  of  such
damages or claim. In particular, Electronic Learning Systems shall have no liability
for any programs or data used with the program, including the costs of recovering
such programs or data.
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Introduction

NOTE: ChatNet Free will be referred to as ChatNet throughout the
rest of this manual.

About ChatNet
ChatNet  provides  text–based  communication  and  file  transfer  between
interconnected Macintosh computers.  ChatNet does not require a Server to take
advantage of its features, although one or more Servers may be used for storing
Preference settings.
ChatNet’s simple interface will be familiar to anyone who uses major online services
and quickly learned by those who haven’t experienced network communications yet.
Users  interact  via  public  and  private  conferences,  send  private  messages,  and
transfer files to each other.
ChatNet is not a mail program. Messages are not stored for later retrieval; they are
delivered immediately between ChatNet users. Preference settings give the ChatNet
Administrator  complete  control  over  the  ChatNet  environment,  from  completely
open to totally controlled.
ChatNet is the perfect tool for schools, businesses, and departmental workgroups.
Hold online teacher conferences and one–on–one teacher–student communications.
Workgroups  can  discuss  project  status  and  strategy  at  the  click  of  a  button.
Employees can reach one another for question and answer sessions and save the
conversation to  a text  file for  later reference.  Simplicity of  use with options for
speech, font, font size, and text color make ChatNet enjoyable to use.

System Requirements
ChatNet requires any Macintosh computer (Mac SE or newer) running System 6.0.5
or  higher,  including  System 7.5.  RAM memory  of  550K is  recommended with  a
minimum setting of 450K. Disk space of 800K should be available for the program
and its support files. The network must be LocalTalk or EtherTalk compatible.
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Installation

Installing ChatNet

Step 1 — Double Click on ChatNet to Launch

Step 2 — Decide on Location for ChatNet’s Data Files

There are two choices for ChatNet’s Data Files: one data file per computer or, if a
Server is available, one data file per Server serving all its connected computers.
Choosing  one  data  file  per  computer  (data  files  are  located  on  each Macintosh
startup  disk)  allows  for  greater  flexibility.  Each  computer  can  have  completely
different  preference  settings,  if  desired.  However,  multiple  data  files  are  more
difficult to administer and offer more opportunity for security problems.
Placing a settings file on a Server hard disk volume (if available) allows greater
control. Preferences can be set once for all computers connected to that Server.
Changing  a  preference  setting  for  a  ChatNet  data  file  on  the  Server  will
automatically update the ChatNet preference settings for all connected computers.

Step 3 — Choose Volume for ChatNet’s Data Files

Double–click the ChatNet icon to launch. If no data files have yet been created, a list
of available hard disk volumes appear. Select the volume to install ChatNet’s Data
Files by clicking once on the volume name and click the OK button. Installation is
complete!

Note: System 7 users can set ChatNet to automatically startup when the computer
is started. Create an Alias of ChatNet and place it in the Startup Items folder of
the System Folder. 
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Installing the Same Preferences to Multiple Computers
When installing to multiple computers and each computer will maintain its own data
files (that is, ChatNet Data Files will NOT be located on a Server), installation and
configuration  can be accelerated  and standardized by configuring  one computer
with all  the desired preference settings and copying those settings to the other
computers.
Choose one computer to become the “master” computer. Install ChatNet and set all
preferences to the desired settings (refer to  Setting Preferences). After configuring
the “master” computer, locate the Chat ƒ folder located at the root of the hard disk
on the “master” computer. Copy the Chat ƒ folder to a floppy disk. Copy the Chat ƒ
folder from the floppy disk to each computer. When ChatNet is first launched select
the Startup Volume for ChatNet’s Data Files, all computers will now be configured
like the “master” computer. This same process can be repeated after ChatNet has
been initially installed by replacing the Chat ƒ folder on each computer with a new
“master.” ChatNet should not be running during this process.
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Features

Logging In
A login screen appears when ChatNet is launched. The usual way to login is by
typing a name in the name box. However, this may be changed by a Supervisor user,
through ChatNet Preferences to either the Computer Owner Name or Menu Master
Mac user login name (refer to User Preferences-ChatNet User Name).

Type your name in the Name area and click the Login button. The public Chat Room
initially  titled  “Lobby”  is  displayed.  All  the  powerful  communication  features  of
ChatNet now become active.

Sending and Receiving a Public Message
Sending a public message is easy to do. By default,  the Lobby is the first  room
available. Since the Lobby is a public room, any message sent while in the Lobby
can be seen by anyone currently in the Lobby.
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Just begin typing in the message preview area (located at the bottom of the window
to the left of the Send Message button). The text in the message preview area is
completely editable until the  Return key is pressed or the  Send Message button is
clicked.  After  the  message  is  sent,  the  message  preview  area  is  cleared.  The
message is sent to all computers currently running ChatNet and the message can
not be changed. A message may contain up to 255 characters.

Sending and Receiving a Private Message
A private  message  operates  exactly  like  a  public  message  except  that  only  the
person you are sending to can see the message. To send a private message, click the
Users button  or  select  List  All  Users… (⌘–U)  from the  File  menu.  Highlight  the
desired user and click the  Private  Message button.  A Private Chat Room window
opens for both you and the selected user and displays your names in the title bar.
Anything that is typed in the message preview area will only be seen by the two of
you.

Public Chat Rooms

Creating New Chat Rooms

Simultaneous conversations can be established by creating additional Chat Rooms.
To create a new room, choose Create Chat Room… (⌘–N) from the File menu. Type in
a name to identify the room and click the Enter button. Try to title your room so that
other  users  that  may  want  to  join  you will  know what  your  primary  subject  of
conversation is. The front–most window is the only window that text can be typed in
the  message  preview area.  Multiple  Chat  Rooms can be opened simultaneously,
however, text can only be typed in the front–most window. To change the front–most
window, click once on any part of a room’s window or select the desired room from
the Windows menu.
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Inviting Other Users to a Chat Room

While in any Chat Room, click the  Invite button of the Chat Room window. A User
List window is displayed. Highlight each user you want to invite from the list of
users and then click the Invite button. 

The Invitation Message screen appears. Type in an invitation message and click the
Invite button.
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The users  receiving  the  invitation  will  have  the  choice  to  Accept or  Decline the
invitation. 

If the Accept button is clicked, the Chat Room is automatically entered. If the Decline
button is clicked, the invitation is cancelled.

Joining Chat Rooms

Anyone can join a public room while a conversation is in progress. To enter a public
Chat Room, choose List Chat Rooms… (⌘–R) from the File menu. Clicking the Rooms
button of  a Chat Room can also display the Chat Room List  window. Select  the
desired room and click the Enter button. To view a list of the users in a highlighted
room, click the Users button on the Chat Room List window.

Ignoring Users

If someone is causing a disturbance in a Chat Room by saying things you do not like,
you may ignore that user. Click the Users button, highlight the offending user, and
click the  Ignore button. The word (Ignored) is appended after the user’s name on
your Users List. Any text that user sends will not be displayed on your computer.
Choosing Ignore also stops invitations, file transfer requests, and private messages
from that user to you. 
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To stop ignoring a user, click the Users button again, highlight the user and click the
Ignore button. The word (Ignored) is removed after the user’s name. Ignoring will be
turned off and the user can communicate to you again.

Hidden Chat Rooms
Creating a hidden Chat Room is very similar to creating a public room. To create a
hidden Chat Room, choose Create Chat Room… (⌘–N) from the File menu. Type in a
name to identify the room and click the Hide Chat Room box. Click the Enter button
The hidden  Chat  Room has  {braces} around  its  name in  the  title  bar.  This  is  a
reminder that the Chat Room is not visible to any one who has not been invited. To
invite users to the Hidden Chat Room (refer to Inviting Other Users to a Chat Room).

When the Chat Room List is displayed, hidden Chat Rooms do not appear in the list.
Users can not enter a hidden Chat Room unless they are invited by someone already
in the hidden room or they know the exact name of the room. All other features of a
hidden Chat Room work identically to a public room.

Sending and Receiving Files
ChatNet allows files to be transferred from one user to another user. To send a file
to a user who is in a public or hidden room with you, click the  Users button or
choose Send File… (⌘–S) from the File menu. Highlight the user to receive the file
and click the  Send File button. A dialog box opens to allow a file to be selected.
Navigate through the file directory and highlight the file to send. Click the  Select
button. A user can chat and perform other operations while the file is being sent.
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If you are in a private Chat Room, a file may be sent directly to the other person by
clicking the Send File button.

Once a file has been selected to be sent, a File Transfer window is displayed on the
sender’s  screen  and  a  Save  dialog  is  displayed  on  the  receiver’s  screen.  The
sender’s  File Transfer window will display “Waiting for receiver” until the receiver
selects a place to save the file or cancels the transfer.
To accept an incoming file from another user, navigate within the Save dialog and
click the  Save button to begin file transfer.  To decline the file transfer, click the
Cancel button. Once the file is accepted, a File Transfer window is displayed on the
receiver’s  screen.  The  estimated  time  for  the  file  transfer  and  a  percentage
completion indicator are displayed. When the file transfer is completed a window is
displayed noting the successful transmission. A voice says “file done.” Click  OK  to
close the window.

Note: Network traffic is always being evaluated to adjust file transfer speeds. This
makes ChatNet’s  file  transfer  protocol  as  efficient  as  possible  without  slowing
down the entire network. 
Note:  All file transfers and message text are encrypted before they are sent over
the  network,  preventing someone with a network snooping device or  program
from capturing any files or text messages. 

Logging Off
Selecting Logoff (⌘–L) from the File menu allows a user to exit all Chat Rooms and
return to the login screen enabeling another user to login.
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User Options

Text Options from the Menu Bar
The  Font,  Size and  Color  menu choices can be selected at any time to change the
font, font size, and text color. When the font or size is changed, all text in all rooms
immediately changes to reflect the new choice. Changing the text color only affects
the text you type in the current Chat Room. All future typing in that room will be
displayed in your selected color for all users in that Chat Room with color monitors.
Each user  controls  their  own text  color.  Using text  colors  is  a  great  method of
quickly separating messages from different users.

Copy and Paste Chat Text
While viewing any room, the text can be copied by highlighting the desired text and
selecting  Copy (⌘–C)  from the Edit  menu.  That text  can then be pasted to  any
application that supports text by selecting Paste (⌘–V) from the Edit menu.

Erasing Chat Text
If a room becomes too cluttered with text or you want to prevent someone from
reading  a  conversation  on your  monitor,  click  the  Erase button.  The  text  in  the
current Chat Room is cleared.

The Windows Menu
The  Windows menu does more than simply list the open windows. The front–most
window is indicated by a check mark ( ✔ ) and Chat Rooms with new messages you
have not yet read are preceded by a bullet ( ● ). Text can only be typed in the front–
most window.

Saving Chat Room Text
To save a Chat Room discussion, choose Start Room Capture… from the File menu. A
dialog box opens to allow the log file to be saved. Navigate within the Save dialog
and click the Save button to begin capture of the discussion. Only future discussion
text will be written to the log file.
To stop capturing a discussion, select  Stop Room Capture… from the File menu. If
multiple discussions are being captured to  multiple logs,  the  Stop Room Capture
command applies to the discussion occurring in the front–most window.

Printing Room Text
To print the text of the front–most Chat Room window, choose Print… from the File
menu.
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Speech On/Speech Off
Selecting  Speech On from the Preferences menu enables sythesized speech. When
selected, the menu item toggles to display Speech Off. ChatNet supports MacinTalk,
PlainTalk, and Apple Speech Manager. When speech is on, messages in the front–
most window are spoken in addition to being displayed on the screen. 

Speech Preferences
To access the Speech Preferences dialog box, Speech On must be enabled. The scroll
bars allow the volume, rate, and pitch of the voice to be changed. Computers using
MacinTalk 2, PlainTalk, or Apple Speech Manager can also select what voice to use.

Volume

The  volume  scroll  bar  allows  the  volume  of  the  voice  to  be  changed.  Volume
increases as the thumb indicator moves from the left to the right.

Rate

The rate scroll bar changes the speech rate of the voice. The speech rate increases
as the thumb indicator moves from the left to the right.

Pitch

The pitch scroll bar changes the pitch of the voice. The pitch increases as the thumb
indicator moves from the left to the right.

Voice

The voice  pop–up menu allows different  voices  to  be  selected.  When a  voice  is
selected,  the  rate  and  pitch  are  set  to  that  voice’s  default  settings.  Computers
without MacinTalk 2, PlainTalk, or Apple Speech Manager revert back to MacinTalk
1 and ignore the voice setting. 

Note: ChatNet’s  memory  partition  may need  to  be  increased  to  support  some
voices.
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Test

Clicking  Test will speak the words “These are the current speech preferences” to
sample the current speech preferences.
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Supervisor Access

Supervisor User
Supervisors have complete access to all of ChatNet’s features except changing the
default preferences. Supervisors are not affected by options in User Preferences.
To become a Supervisor,  choose  Supervisor  Access… from the Preferences menu
while  on  the  login  screen.  Type  the  Supervisor  Password  (initially  set  to
“supervisor”) and click the OK button. Enter your name and click the Login button
and you will login as a Supervisor user.

Supervisors can be identified in Chat Rooms by the brackets (example: [Supervisor
Name]) surrounding the user name.

Stealth Users

When the Supervisor password is typed, a new button appears on the login screen.
When the Stealth option is selected, no announcement of your presence is made in
the Chat Rooms and your name does not appear on any user list. ChatNet room
discussions can be monitored without the users’ knowledge. 

Note: Your presence will remain secret until you send a message. A stealth user’s
name is surrounded by braces (example: {Stealth Name}) when a message is sent.
However, stealth users still do not appear in any user list. 
Note: Supervisor users can always see Stealth users. 
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Setting Preferences
ChatNet’s  preferences  apply  to  either  a  single  computer  or  the  entire  network
segment,  depending  upon  the  location  of  ChatNet’s  data  files  selected  during
installation.  Only  a  user  with  the  Supervisor  password  has  access  to  ChatNet
Preferences… menu  item.  Access  to  ChatNet  Preferences requires  an  additional
password for security. This password should be carefully protected.

ChatNet Preferences
Accessing  ChatNet  Preferences… from  the  Preferences  menu  requires  the
Preferences  password.  Type  the  Preferences  password  (initially  set  to
“preferences”) and click the OK button. 

Note:  The Preferences password should be changed and kept secret even from
other Supervisor users. Supervisor users with the Preferences password have the
ability to totally change all ChatNet settings. This includes the ability of changing
all passwords preventing you from accessing ChatNet Preferences. 

Startup Chat Room

Type the room name for ChatNet’s initial public conference room. The initial setting
is “Lobby.”
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Supervisor Password

The Supervisor Password allows a supervisor, manager, or teacher to use features
not allowed by general users. For example, if the settings under User Preferences
do not allow file transfers, someone with the Supervisor Password can still transfer
files.  Users  with  only  the  Supervisor  Password  can  not  change  any  ChatNet
preferences. The initial password is “supervisor.” Supervisors can become Stealth
users.

Preferences Password

The Preferences Password allows any of  the preferences used by ChatNet to be
changed. This password should be kept confidential by the network administrator.
Users with the Preferences Password can change any ChatNet preference at any
time when they are logged in as Supervisor. The initial password is “preferences.”

Room Text Wrap Limit

The Room Text Wrap Limit specifies how much text will be maintained in each Chat
Room’s scrolling window. Once the limit has been reached, the oldest text will be
discarded.  The  initial  text  wrap  limit  is  5,000  with  a  minimum  of  2,000  and  a
maximum of 32,000 characters.

Limit to Local Network

If  there  are  routers  or  bridges  on  the  network,  turning  this  option  on  allows
discussions,  messages,  and  file  transfers  to  occur  only  with  computers  directly
connected to your network segment. The initial setting is off.

Font and Font Size

Select the font and font size to use as the default for ChatNet. This choice does not
prevent a user from changing the font, font size, and text color that they see on their
screen. However, changes the user makes will not be saved after logging off. The
default font and size are restored at the next user login. The initial font and size
settings are Geneva 9.
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User Preferences
The User Preferences button accesses the User Preferences dialog box. User options
are presented providing the administrator total control over what users are able to
do within ChatNet. These preference settings do not affect users who login with the
Supervisor password. Preference settings stored on Server Volumes will not become
active until the current users logoff.

Send/Receive Private Messages

Allows or disallows users to send and receive private messages. Remember that a
private  message  only  exists  between  two  users.  This  setting  does  not  control
whether a users can create a hidden Chat Room. Private messages sent to or from a
Supervisor are always allowed, regardless of this setting. The initial setting is on.

Send/Receive Files

Allows or disallows users to send and receive files. Files sent to or from Supervisors
are always allowed. The initial setting is on.

Send/Receive Invitations

Allows or disallows users to send or receive invitations to public or hidden Chat
Rooms. Invitations from Supervisors are always allowed. The initial setting is on.

Ignore Users

Allows or disallows users to ignore messages from other users. A Supervisor can not
be ignored. The initial setting is on.

Create Chat Rooms

Allows or disallows users to create public Chat Rooms. The initial setting is on.

Create Hidden Rooms

Allows or disallows users to create hidden Chat Rooms.  A user must be able to
create public Chat Rooms to be able to create hidden Chat Rooms. The initial setting
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is on.
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Create Room Log

Allows or disallows users to create a file which will contain any new discussion that
occurs in the room. The initial setting is on.

Print Room Text

Allows or disallows users to print the text of the messages in the current room. The
initial setting is on.

ChatNet User Name

Determines how user names are set at Login.
Selecting User Entered Name allows a user to type in any name they desire. This is
useful when users move around frequently, but also allows a user to type a false
name. This is the initial default setting for user name login. 
Selecting Owner Name reads the name recorded in the Owner Name section of the
Sharing Setup control panel. This is useful when users remain at the same computer
consistently. However, there is no guarantee that another person is not sitting at
that computer temporarily.
Selecting Menu Master Name should only be selected by those also using Electronic
Learning System’s Menu Master Mac desktop management and security product.
With this option, more trust can be placed in the accuracy of the user name and the
actual person logged into ChatNet. 

Note: Do not use this setting if Menu Mater Mac is configured for multiple users to
access the same login name. If ChatNet is set as a startup item, when a user logs
out of Menu Master Mac, they are also automatically logged out of ChatNet.

24



25

Default Speech Preferences
The Speech Preferences button will access the Default Speech Preferences dialog box
when  Speech  On is  enabled.  While  these  settings  appear  similar  to  the  speech
settings available to each user, the changes made become the default settings when
users login. The scroll  bars allow the volume,  rate,  and pitch of the voice to be
changed. Computers using MacinTalk 2, PlainTalk, or Apple Speech Manager can
also select what voice to use.

Enable Speech Option

Turning on the Enable Speech Option allows access to the Speech On/Speech Off
option from the Preferences menu. The initial setting is on.

Speech On at Startup

Turning on Speech On at Startup automatically turns speech on when ChatNet is
launched. The Enable Speech Option must be turned on to set this option. The initial
setting is off.

Volume

The  volume  scroll  bar  allows  the  volume  of  the  voice  to  be  changed.  Volume
increases as the thumb indicator moves from the left to the right.

Rate

The rate scroll bar changes the speech rate of the voice. The speech rate increases
as the thumb indicator moves from the left to the right.

Pitch

The pitch scroll bar changes the pitch of the voice. The pitch increases as the thumb
indicator moves from the left to the right.
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Voice

The voice  pop–up menu allows different  voices  to  be  selected.  When a  voice  is
selected,  the  rate  and  pitch  are  set  to  that  voice’s  default  settings.  Computers
without MacinTalk 2, PlainTalk, or Apple Speech Manager revert back to MacinTalk
1 and ignore the voice setting. 

Note: ChatNet’s  memory  partition  may need  to  be  increased  to  support  some
voices.

Test

Clicking  Test will speak the words “These are the current speech preferences” to
sample the current speech preferences.

Censor List
The  Censor List button will  access the  Censor List  mini editor screen.  Words and
phrases entered here will not be displayed or spoken. Instead, each letter will be
replaced by a bullet (•) character. Enter each word or phrase followed by pressing
the  Return key. Enter ONLY one word or phrase per line. Only text that  exactly
matches  an  item  in  the  censor  list,  including  spaces  and  punctuation  will  be
overprinted with bullets. Therefore, it is best to divide phrases into their smallest
part to achieve the most consistent censor action. 

Note: Even user names can be censored. If this happens, no one will know who is
sending a message.
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Changing ChatNet’s Data File Location
After initially installing ChatNet,  if you decide to switch from individual ChatNet
Data Files on each computer to one Data File on a Server, ChatNet’s data files must
be relocated.
To perform this operation, launch ChatNet. At the login screen, press both the Shift
and  Option keys while selecting the  Preferences menu. A new menu item appears
titled Set New Chat Volume. Selecting this option displays a dialog box requesting the
Preferences password. Once the correct password is typed, the  Choose Volume for
ChatNet’s Date Files window is displayed. Select the Server Volume and click the OK
button.

Note: The same procedure can be used to switch from using one Data File on a
Server  to  individual  ChatNet  Data  Files  on  each  computer.  When  the  Choose
Volume for ChatNet’s Date Files window is displayed, select the Startup Volume and
click the OK button.
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Quick Reference

Buttons on the Login Window
Enters ChatNet using the current name in the Name box.

Quits the ChatNet program.

Buttons on Chat Room & User Windows
Enters the selected Chat Room.

Invites selected users to join the current Chat Room.

Sends a file to the selected user.

Sends a private message to the selected user. 

Erases all text displayed on the current room window.

Displays a list of users in the current Chat Room.

Displays a list of all public Chat Rooms.

Ignores all actions from the selected user.

Sends the text in the message preview area.

Buttons on Preference Screens
Opens the User Preferences dialog box.

Opens the Speech Preferences dialog box.

Opens the Censor List editor screen.

 Tests the current speech settings.
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